
  

 

AAccttiivvIInnssppiirree  
 

Overview 

With ActivInspire teachers use the software to design interactive, whole-
group lessons to be projected on the Activboard. Inside the ActivInspire 
software, these lessons are called “flipcharts.” Flipcharts can be developed 
entirely within ActivInspire or as a base to launch other applications or 
activities. 

ActivInspire has a selection of tools in the Tool Menu for teachers to use with 
students such as ad hoc voting, desktop tools, math’s tools, camera tools, 
notes, shape and text recognition.  

Main Toolbar: - Contains the basic whiteboard tools which can be added to 
with an extensive selection of optional tools in the Tool Store. 
Small version shows the default position of the toolbar also enlarged for 
Clarity 

Flipchart Controls: - Arrows control the navigation of the Flipchart  
(now in the toolbar) 

The browser combines features that had previously had separate toolbars: 
Resources, Page Browser, Object, Notes, Properties, Actions and Voting.  

One example selected: Resources Browser: - Over 5000 searchable 
resources are included with the software, which can be added to as a 
shareable or personal resource. ActivInspire comes with thousands of 
searchable resources, and the ability to metatag your flipcharts, creating 
you and your colleagues own searchable resource bank. 

Once the icon is clicked the Browser changes to reflect options associated. 

A good port of reference is the help within Inspire. Click the      icon and 
search for “First steps with ActivInspire”. In the results area, click on that 
phrase to display this introductory section.   
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The Toolbox  

The Tools 

 

Nb There is no Text Tool 
Use the select tool move cursor to 
where you want type and start 

typing. 

Shapes 

Docking Option: 
Float or stick to side etc. 

Roll up/down roll in/out buttons 
nb Toggles  

Minimise tools to just a title bar 

Pen nib sizes (small) 
1. Pen Colours, 

 8 16 or 24 available 
  

Annotate and Desktop Tools 
Allows you to write over 
programs e.g. Word or 
PowerPoint Toggle click to 

go back to   Desktop. 

Menu 

Sliding Pen nib 
(Variable large sizes ) 

Pen (Click to select) 
Right Click to get additional line 
and object  menu  

See menu on next page → 
Highlighter 
Nib Sizes can be changed 

Select Tool 
(Marquee select tool) 
Use to select, adjust 

and move everything!! 

7. Eraser 
Nib Sizes can be changed 
Nb does erase, old eraser now 

called magnetic ink 

Tools 
Access to extra tools.  

Connectors 
Draws lines and curves. 
Use nib size for line thickness 

thickness 

 Resource Browser 
Page Browser 

Clear  
Clear Text, Graphics, 
everything! 

 

Undo and Redo 

Design Mode 
Allows objects to be 
edited and changed.  
Not by accident 

Help 

The blank area to the right of the 
tools fills up with the most recently 
used tools used: Currently Design 

and Help have been used 

Create or select a profile. 
Allows teachers to create their own 
profile 
e.g. files, favourite tools, shared team 
resources.  
All selected ready to use 

Current profile selected 

Fill Colour 

Reset: a useful tool  
Resets a saved flipchart to its saved state. 

Students can attempt a labelled diagram. 
Reset and another student can have a go.  

Roll in (See Docking option at top). 
Note that the toolbox is rolled out 
displaying an extra column to show 
your frequently used tools. You can 
drag Shapes to this area as well. 



  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tool Topics  

The Shape and Line Tools 

 

 
Note the chevrons at 
the bottom 
Click these and you 
get the complete 
menu shown here 
 

The Connector Menu,  
Nb All of the connector 
shapes are in the 
connector menu 

The Full 
Shape Menu 

 

Shape and 
Connector Icons 

When either the shape tool or 
the connector tool is clicked 
(above) a menu to the right of 
the flipchart appears. 
 
Nb This is the Full shape menu  
 
Click the chevrons to access.  
See the chevron note  
below right 
 

 
Most Graphics editing tools work the same way, so as you understand editing objects, layers and 
properties, using any graphics editing program will become much easier.  
 
Remember if you are preparing at home and not using the board, lines may appear to be too thick on 
the screen but at the back of the class it may be just right. Draw some practice shapes and check 
what seems best to you in the classroom. 
There are many images and shapes you can get from the Web but sometimes you just can’t find one 
and you need to draw it yourself. 
 
Once we’ve covered the basics we’ll create some more complex shapes. 
 
You can save these for future use by adding them to your resource library. 



   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

Using the Board 

 

Try watching one of your colleagues who is experienced using the board you’ll pick up lots of things 
that they aren’t able to tell you. They just do!   

Watch how they stand at the board; notice the shadow from the projector. Holding your arm slightly 
further out from your body allows you to see what you are writing, Some people are able to write 
facing the class, the only shadow cast is from the wrist and pen but that is a learned skill and is not for 
the new user. It is very different from using a dry whiteboard. 

Much about using the board is personal, e.g. when writing as with paper some will like using thin pens 
some of you will like thicker lines. 

Flipcharts can be used at the time or pre-prepared; the resultant notes can be saved at the end of the 
session for reuse with another group or printed for distribution to the students. 

Plainly a flipchart that is prepared will be neater and possibly more structured. Used with some of the 
tools that come with program you can create session you are proud of. 

For very new users 

 You need to keep a gentle pressure on as you write; else your text line will break up.  

 Position yourself so your shadow doesn’t hide what you are writing. 

 Don’t pick too fine a nib size to write with if your writing is untidy it will accentuate it. 

 Remember you have unlimited flipchart pages to turn to and look back at so turn to a new 
page for your next point,  

 Plenary: it easy for you to look back over the lesson, in your plenary stage you can quickly 
flick through the pages  highlighting key points 

 Prepare some of your pages in advance of the lesson they can add as aide memoirs or can 
be parts that would take too long to set up in class 

 
The pen itself is stored on the side of the board and is a multi function tool that works like a mouse, 
the tip is the left mouse button, the grey button on the side is the right mouse button.  
 
Using the pen to write: 
Click the pen icon to start writing. The defaults are black and with a pen size of 4,  
Adjust the colour and pen size to suit. 
 
(Nb the highlighter works the same just has broader nib) Choose highlighter! 
 
On the board tap where you want to write and write away. 
 
You need to keep a gentle pressure on as you write; else your text line will break up. It’s a knack 
easily picked up. Once you finished writing, you can select all you’ve written and make it larger or 
smaller. Then move it to anywhere on the board.  
Useful if you want to put in order what you’ve said to the class. 

 

The Pen 

Using the Board 



 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Deleting text 
Occasionally you may make a mistake , and want to delete a word or letter. 
Inspire treats any letters not joined as separate objects. This can be convenient or a nuisance when 
you want to change one letter or change a sentence, here we need to select all of the letters to delete.   
 
Select and delete the text. 
Choose the Select icon drag and cover the text you want to want to change. Easy to demonstrate, 
hard to explain. 
 
This is the same action as you may have used in Paint or other graphics programs. 
Find a free area away from other letters usually top left of the text press the pen tip and drag to the 
bottom right. Release and you should have an effect like these two pictures as you begin to highlight,  

 
 
 
 
 
 
 
 
 
Then the graphic after you’ve let go with the icons that appear. 
I’ll refer to this graphic later with detail of what the icons do, but for now, to delete              
drag the text to the bin using the X or press delete on the keyboard 
 
Eraser: Strangely this is a new feature for Inspire; the old eraser is now called magnetic ink. This one 
does erase hand written text but not shapes or lines. 

Deleting Text 

Drag the Object 
to the bin 

 
 
Deleting Lines shapes or other objects like pictures.  
Select them using the select tool and drag them to the bin or press delete.  
 
Alternatively use the Clear tool  and use the options within it 
 
 

Clear Annotations: Clear all handwritten text 

Clear Objects: Clear shapes, lines and pictures 

Clear Grid: (found in the resources browser) 

Clear Background: (found in the resources browser) 

Clear Page: Blank the page of everything - Clear all 

 

Deleting Objects 

Deleting  



 

 

 

 
 
This includes lines Shapes and Pictures; you can do the same in Word, PowerPoint and Excel 

The Promethean help is quite good here Click the  type “shapes” in the search box and choose “Adding and manipulating shapes”  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Working with Objects 

Access Points 
Allows you to deform the shape 

Make object  

bigger or smaller  

Resize both horizontal and vertical  
Will distort if not careful, unlike most GFX packages 

shift does not work to maintain aspect 

Rotate 

Move 

Translucency: See Text: Shape 

above can be made to show shape beneath, 

See main picture 

Properties 

Group: See text Shapes can be grouped together to stop them 

breaking apart when moved. 

Bring object forward or Send backward 
See Text: You can place your shape on one of 4 layers. Top, Middle 
Bottom and Background. This means one shape can be above another  

Duplicate: Copy 

Resize maintains aspect ratio 
gets smaller or larger without distortion  

Resize Resize 

Working with Objects 

Topics  



 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Design Mode 

 
There are some really good aspects of the drawing tools Containers and Restrictors 
which will allow you to produce drag and drop quizzes.  

But overall it is clunky and it is easier to draw using Words drawing editor which also follows 
drawing conventions more closely. 
So if you are doing this at home as prep you may find it easier to draw in Word, group and 
copy the finished object over to the flipchart. 

 Still it works…These tips will work in most drawing packages including Freehand, Corel and 
Words little editor.  

Rather than drawing a silly little shape here, toward the end of the document I’ll create a 
series of activities that hopefully you’ll be able to adapt to your own subject matter. 

But here are some tips for drawing you may find useful. 

Once you finish using a tool press the select tool to deselect else you’ll keep applying that 
action. 

 Check the line thickness, Default is 4, too thick for me. Choose a thinner one after 
you choose the tool clicking the smallest nib size on the tool box.  
It remembers that for the session. 

 Fill: If you choose a shape then a fill is already applied mine was orange, I would 
prefer White. 
Click the paint pot (fill) and choose a colour (white!) and click the shape the contents 
will change colour if you want the border to change colour as well click the borderline.   

 Nudge: once drawn objects may need positioning a little and using the mouse or the 
pen can be hard, so select the object and use the arrow keys to nudge into position. 

 Selecting Objects: all items on the page are objects 
Tap them singly with the pen or click with the mouse the handles will appear. 

 Selecting multiple objects:  to select more than one object drag the highlighting 
canvas to cover or part cover the objects. 
Nb This drawing program requires you just to touch the object with the canvas so if you 
don’t want to include a line don’t include it at all. 
Some drawing programs require the reverse you have to include everything, miss a bit, 
and it won’t be copied. Words Drawing tool is like that. 

 Translucency Allows Objects to show through, useful on a Venn Diagram where you 
want to be able to see the intersection, rather than one circle hiding the other. 
 

Two very important areas are Ordering, Layers and Grouping. 

See next two pages 
 

 

Select Design Mode         Click Blue icon top right, glows red in design view) 
Before you start editing enter design mode, this over rides any locking or object 
restrictions so that you can freely move and edit objects. When finished editing, exit 
Design Mode.  
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Ordering is very important and can be confusing thus becomes frustrating 

 The first premise is that the first drawn shape is at the bottom last item is at the top  
 

 
 
 
 
 

 You can bring pictures forwards or send backwards   
This works for photos as well with text on top of a photo or map with symbols on it 
 

 
 
 
 
 
 
 
 
 
 

Ordering Objects 

 

 
Next stage is Layers: Inspire has four transparent layers  
rather like OHP sheets one on top of the other. 
The called: Top, Middle, Bottom and Background. 
 
The last one is only for backgrounds and grids so when you put a background from resources 
it goes to the very bottom layer, which makes sense, though you can put things there. 
 
You have the option of specifying where images go, but for most cases you will just be 
plonking images on quickly and getting on with your lesson. Occasionally you may want to set 
up a flip chart to be reused. Perhaps a difficult concept or preparation to a practical. Take this 
example 
 
Image of stomata put on middle layer  
(right click reorder send to middle layer) 
 
Image of Leaf put on top layer  
(default) 
 
Move top leaf over stomata  
(lock the image, so it’s not moved by accident) 
 
Using magnetic ink make a magnifying glass 
 (it makes the top layer transparent) we can see the object beneath. 
You can hide answers beneath questions and reveal them. No end of fun!  
Full details how to do this at the end of the manual  
 
Add the magnifying glass to the right side of the toolbox. Just click it to use! 

 
 
 

Layers 
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Background 



 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

  

 

 

Grouping Objects 

 

 
Another important area, quite easy though. 

 

When you have many objects that make up one picture, it’s useful to group them. For example 

say it was a little house you’d drawn. Dragging the house would likely just move a wall or a 

door. 

So highlight the whole assembly and click the group icon. 

It is good practice to group areas you may duplicate, so keeping the analogy going you may 

group the window assembly so you can duplicate it three further times. Once the house is 

complete group everything then all will move together. 

Grouping example 

On a more likely scenario it is useful to group labels around an image; again this moves 

everything together rather than a label being moved out of position by a student at the board. 

 

 

 

 

You’ll remember this image from earlier: 

 Create Text box labelling the circle 

 Move into the circle  

 Select the circle and the text together 

 Then click the group icon. 

 It now moves as one. 

 Repeat for the other circles. 

This works with any graphics program including Words Shapes and lines 

 

 

 

To Edit  

 Ungroup by: 

 Click the grouped image 

 Click the Grouped Icon again.  

 Click any object to deselect 

and then reselect the object to be moved or edited, make the alteration 

 Then group again once modification is done 

 

 
 
 
 
 

Group icon 

How to Group 

How to Ungroup 

 

Once pictures or other objects are in place you can lock them in position this prevents  
accidental movement by yourself or by your students.  

 Merely click the object to select 

 Right click (or pen button) select the padlock to lock 

 To unlock (must be in Design Mode click Blue icon top right, 
glows red)  
Uncheck locked                 

e.g.  
Lock an outline plant cell, have the various cell components at the 
bottom or sides to be placed by your students. 

Lock 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 

  

 

 

 

 

 

 

 

Resource Browser 

 
 
This view of the Browser window is the Resource Browser found on the Left side Of Inspire. If 
not visible Click view Browsers.  
It flies out for a moment then tucks away in the Left side of the window. To pin it to and let it 
remain out Click the Pin Icon (see image top right) Click again and it will slide aside. 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

Pin the browser 

Path to where your 
resources are 

Voting 
Properties 

Action Notes 
Object 

Resources 

Page 

Personal Resources 

Shared Resources 

Resource Categories 
From the Shared area 

 

These are templates 
from the Brick Category 

 

There are two resource areas one shared and one personal,  
You can add your own resources to either, useful for shared teaching. You can drag resources 
that you create into the resource folders from the Flip chart (Exactly the reverse of putting 
images into your Flipchart) or save them directly into the folders.  
 

You can find where the resources are stored on the next page as it can be changed when 
installed. 
 

Inspire’s help “Working with your own materials” gives some detail on using your own materials. 



 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

There are two resource areas one shared and one personal,  

 You can add your own resources to either, useful for shared teaching. 

 The resource areas are merely nested folders i.e. folders within folders.  

 The Default Drive and folder where My Resources is installed will be dependent on the 
Operating System and effectively installs it on the local machines C:drive 

 This means that Shared is only for any user of that computer (unless you have admin 
rights).  

Important at present,  
Your shared resources will not be available in any other room.  
I’ve copied the resources to the T:\ActivStudio3  
If you alter the paths where inspire Looks for the resources you can find them where ever you 
teach in the College. 
Nb if you just want access to the default resources then you need do nothing, everything will 
work. But if you are creating your own resources, Backgrounds Grids etc., then you’ll want them 
available wherever you are.  

 
 
 

Resource Browser Settings 

 

 
Go to settings:  
File/ Settings 
Profile and Resources 
 You’ll see where your resources are currently being stored. 

 
 
 
 
 
 
 
Uncheck the use default shared 
resources path and browse to T: drive 
and look for the ActivStudio3 directory 
Click it once  
The path should appear 
Click Done  
 
Now any resources you add to the 
browser will be stored on the network 
drive 
 
Nb we are not talking about flipcharts 
here only the resources which you use 
in them. 

 
You can use save as to store Flipcharts to a shared area, which could be the T:drive. 

 

 

 

 

 

 

 

 

 

 

 

Altering the Path to resources 

 

Settings 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 

  

 

 

 

 

 
This button allows the page to return to the state it was opened on a Saved flipchart 
Say you have an unlabeled diagram. 
You ask a student to label it... 
After the attempt you can press reset for another to attempt 
 
With your imagination you can make use of this: Q&A, Jumbled words etc. 

 
 

Reset Button 

 

 
To save you time typing consider dragging and dropping text or graphics from another 
application e.g. Word into your Flipchart, works in Internet Explorer as well 
 
Make sure your flipchart is open at the right page 

1. Select your text/graphic in Word 
2.  Drag the text/graphic into the Flipchart icon on the system tray, let go when in the right 

position as the flipchart opens. 
Works with text and Graphics 

 
Save the resource into the resource browser to reuse another day 

5. Choose My Resources or Shared resources  
6. Locate the Category (folder) you wish to put the picture in or create a new folder.  
7. Drag and then drop the picture into the resource category. 

It will convert the File and add to the library  
 
When surfing on the Web you find a Graphic to use Drag the picture into the resource Browser 
It will save for future use  

Drag and Drop from Word to Inspire 

 

 

Much improved over the old ActivStudio, merely: 
1.  Copy the text or picture 
2. Click on the page you want to paste the text in. 

I click on the page where I want to place the text, type a letter then rub the letter out. 
This puts a text box ready to receive the pasted text  

3. If you don’t do this you’ll have to do some repositioning  as text is placed at the top of 
the Flip Chart 

4. For photos just paste and move to position 
 

Prior to pasting photos you’ve copied from the Web you may want to format them in Word first. 
The Format option once you select a picture allows you to apply some attractive effects very 
quickly. 
 To add drop shadows and mirror effects very quickly  
Select the Picture, then apply format, if the Format menu is not available double click the Photo 
Click on the photo effect you like, then just copy and paste the photo into Inspire. 
Sorted! 

Copy and Paste text or Pictures 
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Working with Backgrounds 

 
 

Now you have got this far you can begin to have some fun, and allow your personality to come 
out! 
Backgrounds can be made to be relaxing, soft colours rather than the default stark white. Or 
can be lively theme based on your current teaching topic, I’m sure they can be complicated 
with many features but for an effective start have a look at these ideas. 
In the Resource browser there are a few Themes you can apply as you can to PowerPoint. 
These are backgrounds and templates ready for you to add text or questions to. 
 

You can find additional resources at PrometheanPlanet.com where there is a great deal to 
download, well worth a visit.. 

 
 

 

Applies to all pages. 
1. In a blank area of the flipchart Right Click 
2. Choose Set Background 

 
3. Leave Fill Selected 
4. Click on small box 

bottom left 
5. Choose a colour e.g. 

cream 
6. Leave other box white 

This will give a gradient of colour changing from 
cream to white. 
If you want a solid colour make the small boxes 
the same colour 
You can also select colours for each box with either 
the colour wheel or the colour sampler  

 

 

Simple Colours 

 

Appearance Topics  

Click small box here 
Choose colour 

Colour sampler, choose a 

colour anywhere on screen 

Colour Wheel 

large range of colours 

Adding an existing Photo Background 

 
Backgrounds are available in the Resource library under Shared Resources Backgrounds.  

If there is nothing suitable you can create your own, this is covered on the next page. 

You’ll find several categories including Illustrations, photographs, grids, paper, patterns and 
texture. 

Click a category and the images preview Drag the background to your flipchart and it 
immediately is applied. 

Previously when we discussed layers the Background layer is the bottom layer and gives us 
three more layers on which to place objects. 

And yes you can add photos and use them as backgrounds just by placing them on one of 
the layers. But to do it properly! They should be set as a background. 
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Appearance Topics  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Making Photo backgrounds 

 
The process is a bit tedious but if you do a few at once it does become easier. 
 And is so easy to use once created. 
 
Once you have created a folder of resources, create a resource 
pack. This allows you easily to share resources with Colleagues 
and upload to Promethean Planet where you’ll find plenty more. 
 
Choose a Photo 

 Paste in place stretch to fit  

 Add a shape to cover the area you’ll be writing on  

 Add a white fill (fill the outline if desired) 

 Adjust the translucency so any writing is clear 
 yet you can see the picture beneath 

 Click outside the image  
right click Export the page 

 Save as jpg 

 Clear page of images  

 Right click on blank page 

 Set Background 
From image /locate saved image 

 Apply/ OK 
Add custom background to resource Library (so you can easily [this time] use again) 
Right click on image add to resource library 
 

 

 

 
Resource packs are a convenient way of sharing resources, made up of images backgrounds 
sounds etc. many are free and some are for sale and can be purchased in much the same way 
you can buy PowerPoint themes and templates. The content is up to the author and may be 
theme based.  

 

Resource Packs 

 

 

Simply: 
Open the resource browser  
Right click on the folder containing the resources 
Choose export to Resource pack 
Give it a name and save appropriately. 
Consider uploading your work to the Promethean 
Planet resource area 

 

Creating Resource Packs 

 

 

Currently at the time of writing there are around 300 free resources packs available to 
download. Visit PrometheanPlanet.com then choose Resources. Resource packs are listed with 
much else  
You can also watch the Activtips video about Creating Backgrounds using the live link here:   
http://www.Prometheanplanet.com/serv...?show=nav.1147  
For paper versions go to Prometheanplanet.com /Professional Development /Activtips and look 
for the video player. 

Importing Resource Packs 

 
 

Start inspire 
File import 
Resource pack to Shared Area or My 
Resources 
It will unpack into a new folder 
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Managing Pages 

 

This is one place where you can really see the changes from the old version. 
Now just one place to manage your pages, duplicate insert and delete them. 
The Page browser is the icon on the left of resources.  
 

Page management 

 

Page Browser 

 To Delete a page select e.g. page 3 
Right click Delete 

 To move the order of the pages Select e.g. page 3 
Drag to desired position, a vertical line will 
indicate where it’s inserting 

 To Copy a page Select e.g. page 3 
Right Click Duplicate 

 Insert a page select a page near where you want 
the page inserted 
Right click Insert page/blank page before or after 
current 

 

 
The mechanics of managing pages are briefly covered above; a little more info may be 
helpful. 
 
A case for Duplication 
If you need an extra page inserting consider duplication what you have done already, if 
some of the content is repeated, e.g. test with questions, test with answers, Image with and 
without labels. It makes sense to duplicate and make small changes. 
 
Create a detailed diagram first with all the labels, then duplicate, on the first page delete the 
labels or move them to the side so students have to position them correctly. Add a clock 
countdown tool set it to blank the screen in 1-2 minutes at an appropriate moment you can 
then turn to the next page where all the answers are. 

 

A couple of tips 
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Desktop annotation allows you to use the Pen, Highlighter and Eraser, on your desktop or 
any Windows and Mac application you have open on your desktop 
 
 
 
 
 
 
 
 

Click the Annotate icon and you leave the Inspire workspace to be over the desktop (or 
whichever application is to the fore at the time. You can start programs and use them as 
normal  
But note when you first switch to the desktop the pen is ready to write, 
If you want to start a program or change place on a page you must click the Select tool. 

Also the resource browser may be open and need closing or unpinning to give you some 
space. Click the pin on the top right of the browser and click the page in about 2 secs it will 
dock to the side. (If you don’t click the side it stays frustratingly stays open). 

When you annotate the desktop, you create a Desktop Flipchart, which can be saved. 

For me it works best on applications that fill the screen and don’t move e.g. PowerPoint, But 
in Word as you scroll the document the annotations stay still so unintentional areas become 
highlighted. But I know Colleagues who love the annotation feature.  

Click to Annotate on the Desktop Click again to leave the desktop.  

When you close the program it will prompt you to save the Desktop Flipchart (annotations) if 
you haven’t already saved them. 

Desktop Annotation 

 

Desktop Flipchart 

 
 

The Desktop Flipchart is invisible, nb. as you annotate you are writing on this flipchart, you 
can copy objects (text and Pictures) from the applications into this flipchart as you work. 

In Backgrounds we set pictures and colours on ordinary flipcharts However as desktop 
backgrounds are clear, you can include a background when you save the flipchart or leave 
it clear. 

To include the background (e.g. the applications you are working on) click set background 
Use Desktop Snapshot, or choose Desktop Overlay for no background i.e. clear. 
Prometheans more detailed instructions follow. 

From the File Menu, select Edit > Page Background. The Set Background Dialog Box 
opens. 

Click the Desktop Snapshot radio button. To look at the desktop before taking the 
snapshot, click the Show Desktop icon.  

When you are ready to take the snapshot, click on the Take Snapshot icon.  

After the snapshot has been taken, click on Done. 

If you want your current page to have no background: 

Click on the Desktop Overlay radio button, then click on Done. 

The desktop does not form part of the flipchart and will not be saved. 

 

Desktop Annotate Desktop 
Tools 

Click the annotate icon 
to start and leave 
Desktop Annotate 
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Desktop Tools 

 
 

This has been greatly expanded and implemented in a very neat display gadget. 
Very impressed! Move about by dragging the centre of the wheel.  
Hover over to get the wheel to expand. 

 

 

Onscreen 
Keyboard 

Camera tools 

Web Browser 
Return to Flipcharts 

Express Poll 

Screen recorder 

More Tools: Clock, Ticker 

tape, Recorder Dice, Calc 

Full Screen: 
Video captured 

Set Area Video 
captured 

Camera tools 

Full Screen 
capture 

Screen recorder 

Active Window 
capture 

Freehand 
capture 

Set Area 
Captured 

Irregular Area 
Captured. 
You click the points 

Screen recorder 

Recorder 
Clock 

Ticker Tape 

Dice roller 

Calculator 

17 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 
 
 
 
 
 

  

 

 

 

 

 

 

 

 

 

 

 

 

Function WindowsTM LinuxTM Mac® 

Help F1 F1 not applicable 

Toggle Design Mode F2 F2 not applicable 

ExpressPoll F3 F3 not applicable 

Dual User F4 F4 not applicable 

Toggle Full Screen F5 F5 not applicable 

Desktop Tools F6 F6 not applicable 

Flipchart Spellchecker F7 F7 not applicable 

Page Browser F8 F8 not applicable 

Property Browser F9 F9 not applicable 

Action Browser F10 F10 not applicable 

Dashboard F11 F11 not applicable 

Promethean Planet F12 F12 not applicable 

    Select All CTRL+A CTRL+A Cmd+A 

Toggle Browsers CTRL+B CTRL+B Cmd+B 

Copy CTRL+C CTRL+C Cmd+C 

Duplicate CTRL+D CTRL+D Cmd+D 

Eraser CTRL+E CTRL+E Cmd+E 

Fill CTRL+F CTRL+F Cmd+F 

Toggle Grouped CTRL+G CTRL+G Cmd+G 

Highlighter CTRL+H CTRL+H not applicable 

Insert Blank Page After 
Current CTRL+I CTRL+I Cmd+I 

Edit Profiles CTRL+J CTRL+J Cmd+J 

On-screen Keyboard CTRL+K CTRL+K Cmd+K 

Insert Link to File CTRL+L CTRL+L Cmd+L 

Insert Media CTRL+M CTRL+M Cmd+M 

Open a new flipchart CTRL+N CTRL+N Cmd+N 

Open an existing flipchart CTRL+O CTRL+O Cmd+O 

Print CTRL+P CTRL+P Cmd+P 

Insert Question CTRL+Q CTRL+Q not applicable 

Revealer CTRL+R CTRL+R Cmd+R 

Text CTRL+T CTRL+T Cmd+T 

View Customise CTRL+U CTRL+U Cmd+U 

Paste CTRL+V CTRL+V Cmd+V 

Close CTRL+W CTRL+W Cmd+W 

Cut CTRL+X CTRL+X Cmd+X 

Redo your last action CTRL+Y CTRL+Y Cmd+Shift+Z 

Undo your last action CTRL+Z CTRL+Z Cmd+Z 

Increase Object Size CTRL+ + CTRL+ + Cmd+ + 

Decrease Object Size CTRL+ - CTRL+ - Cmd+ - 

    

    

    

    Desktop Snapshot CTRL+Shift+D CTRL+Shift+D Cmd+Shift+D 

Export Page CTRL+Shift+E CTRL+Shift+E Cmd+Shift+E 

Bring to Front CTRL+Shift+F CTRL+Shift+F Cmd+Shift+F 

Keyboard Shortcuts 
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    Function WindowsTM LinuxTM Mac® 

Desktop Annotate CTRL+Shift+A CTRL+Shift+A Cmd+Shift+A 

Send to Back CTRL+Shift+B CTRL+Shift+B Cmd+Shift+B 

Connector CTRL+Shift+C CTRL+Shift+C Cmd+Shift+C 

Desktop Snapshot CTRL+Shift+D CTRL+Shift+D Cmd+Shift+D 

Export Page CTRL+Shift+E CTRL+Shift+E Cmd+Shift+E 

Bring to Front CTRL+Shift+F CTRL+Shift+F Cmd+Shift+F 

Grid Designer CTRL+Shift+G CTRL+Shift+G Cmd+Shift+G 

Handwriting Recognition CTRL+Shift+H CTRL+Shift+H Cmd+Shift+H 

Toggle Hidden CTRL+Shift+I CTRL+Shift+I Cmd+Shift+I 

Toggle Drag a Copy CTRL+Shift+J CTRL+Shift+J Cmd+Shift+J 

Camera - Area CTRL+Shift+K CTRL+Shift+K Cmd+Shift+K 

Toggle Locked CTRL+Shift+L CTRL+Shift+L Cmd+Shift+L 

Magic Ink CTRL+Shift+M CTRL+Shift+M Cmd+Shift+M 

Notes Browser CTRL+Shift+N CTRL+Shift+N Cmd+Shift+N 

Circular Spotlight CTRL+Shift+O CTRL+Shift+O Cmd+Shift+O 

Pen CTRL+Shift+P CTRL+Shift+P Cmd+Shift+P 

Edit Question on Page CTRL+Shift+Q CTRL+Shift+Q Not applicable 

Sound Recorder CTRL+Shift+R CTRL+Shift+R Cmd+Shift+R 

Shapes CTRL+Shift+S CTRL+Shift+S not applicable 

Save a flipchart CTRL+S CTRL+S Cmd+Shift+S 

Tickertape CTRL+Shift+T CTRL+Shift+T Cmd+Shift+T 

Clock CTRL+Shift+U CTRL+Shift+U Cmd+Shift+U 

Bring Forwards CTRL+Shift+V CTRL+Shift+V Cmd+Shift+V 

Send Backwards CTRL+Shift+W CTRL+Shift+W Cmd+Shift+W 

Flip X CTRL+Shift+X CTRL+Shift+X Cmd+Shift+X 

Flip Y CTRL+Shift+Y CTRL+Shift+Y Cmd+Shift+Y 

Page Zoom CTRL+Shift+Z CTRL+Shift+Z not applicable 

    Select Esc Esc Esc 

Go to next page PgDown PgDown Down 

Go to previous page PgUp PgUp Up 

Delete Del Del Del 

 

Keyboard Shortcuts 
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Hidden answers that you can reveal and hide 
Use an X Ray Magnifying glass on a leaf and reveal the stomata, or the chick inside an egg. Have the 
surface disappear as you pass a magnifying glass over. Interested? 

 

 

 

 

 

 

 

 

 

 

 

   

 

 

 

 

  

Using the pen tool with a large pen, create a 
large cloud shape any colour e.g. blue (this is 
merely so you can see the erased area). 
With the pen, use the circle tool and create a 
black circle about 2.5cm (1”) 26 pen size (use 
the pen slider) move this circle on top of the 
blue cloud.    
Take the eraser, carefully rubout everything 
within the circle this is fiddly!! Again use the 
slider to adjust the eraser size. Eventually you 
will have rubbed out everything it doesn’t 
matter if you appear to rubout some of the 
circle because it is merely a guide.  
This done you have created a circle shape 
with the eraser, that you can get hold of and 
move around the screen careful though it may 
disappear!  
Now make another circle on top, now draw a 
handle using the line tool. 
Now align the circle on top of the erased area, 
carefully delete the cloud, delete the first 
circle, and align the line so that it is a handle. 
Now group all of the objects, you now have a 
magnifying glass. Drag the magnifying glass 
to the third column on the Flipchart toolkit so 
you can add it to your flip charts whenever 
you want. 
Next your diagram, ActivInspire uses layers, a 
bit like having 4 layers of OHPs each with 
different objects on them and the ability to 
lock the objects from moving. In our case we 
are putting an image at the middle and a layer 
on the top. The top layer being opaque 

prevents you from seeing the image below. 
Your eraser tool enables you to see beneath 
the top layer and see your image below. 

 This bit is where your imagination takes over, for 
the purpose of this exercise, we’ll use a leaf 
 with the stomata underneath .  

Just to show the effect, in the 
image (left) you can see the 
background through the 
magnifying glass. 
Locate the images of the 
stomata and the leaf, perhaps 
through Google, and have them 
ready on the flipchart. 
 
 Place the bottom image first. 
Select the stomata  
  

Right click>Reorder>bottom layer, then lock it. 
Right click>Locked.  
Then position the Leaf hiding the stomata.  
Right click>Reorder>top layer and lock it. 
 
You can see the result with the magnifying glass 

 to the left.  
Nb you can 
enlarge or reduce 
the size of the 
magnifying glass 
the same way as 
any graphic. 

   

 

 

 

  

© Graham Monaghan  graham.monaghan@hpoolsfc.ac.uk 

For educational non profit use. 

This exercise uses  

Layers  

The eraser 

Pen Tool 

Lines 

Shapes  

Locking 

Grouping  

 

Creating a Reveal Tool or 

What lies beneath!  

 

 

Creating a reveal Tool 

What Lies Beneath? 

A couple of tips 
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Plainly there is much that is not covered; this is a guide and not a detailed manual.  
I have no experience with Expression voting systems, though I believe them to be very good, 
these are not covered  

Perhaps someone would like to add to the many omissions? .  I’ll happily format the Doc or feel 
free to format it as you like! 

Please advise me of any errors and omissions my email is at the bottom of the Document.  

 

The Document was created in Word 2007, section breaks were used whenever a new page was 
forced (page layout /breaks for those of you who can’t find them ). 

If printing from Word, in Word Options/Display set the checkbox -  Print background colours and 
images, else it does look very wrong. 

I have deliberately left a blank page to help anyone who would like to add content 
 
Further Development 

Most of us use docs like these online so some in document hyperlinks may be of use. I intended to 
add activities when I first uploaded my ActivStudio manual 3 years ago and still do! A manual like 
this is useful initially but showing how you apply a technique or use inspire in an activity would be 
one way of developing further. 
Rather than just wonderful Flipcharts being put up, How did you do them? E.g. 2 page Worksheets 
how to?  
So others can learn from you. 
 
Please feel free to use in an non profit Educational context.  
I would be interested to know who is using it; my email is at the bottom of the page. 

Hope you find it of use. 

Graham Monaghan Nov 2009 
graham.monaghan@hpoolsfc.ac.uk 
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